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802 Information Technology

ANSWER KEYClass

XI

	Computer Organisation

Unsolved Exercise

Section A  
(Objective Type Questions)

A.	 1.	 iii	 2.	 ii	 3.	 i	 4	 iv	 5.	 ii	 6.	 iii	
	 7.	 iv	 8.	 iii	 9.	 iii	 10.	 iv	
	 11.	 The options of this question was printed incorrectly in the book. Please correct it in your 

textbook.
		  Question:  On a Laptop, the Power button is usually located in ______________ . 
		  i. Top center 					    ii. Left corner 
		  iii. Right corner 	 			   iv. All of these
	 Ans.	iv	
	 12.	 ii	 13.	 iv
B.	 1.	 Biometric Sensor	 2.	 cold cathode ray tube, fluorescent panel
	 3.	 400 to 4000		  4.	 RPM	 5.	 blue-violet
	 6.	 Minicomputers	 7.	 Motherboard Chipset
	 8.	 Input-Process-Output	 9.	 Fetch-Decode-Execute-Store (F-D-E-S)
	 10.	 Address 			   11.	 Gary Arlen Kildall
	 12.	 Multitasking		 13.	 PC-DOS, MS-DOS 
	 14.	 1969			   15.	 Kernel
	 16.	 Network
	 17.	 (The question is printed incorrect in the book. Please correct it in your textbook.)
		  Question:  ______________ are special programs that make computer systems operate more 

smoothly, effectively, and efficiently. 
	 Ans.	 Utilities
		

1.

Part-B: Subject Specific Skills
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C.	 1.	 False 	 2.	 True	 3.	 False 	 4.	 True	 5.	 True
	 6.	 (The question is printed incorrect in the book. Please correct it in your textbook.)
		  Question:  The printing speed of the printer can be improved by changing the default printer 

quality setting from Fast Draft to Normal. 
	 Ans.	 False	
	 7.	 True	 8.	 True	 9.	 False	 10.	 True
D.	 1.	 RAM: Random Access Memory
	 2.	 ROM: Read-Only Memory
	 3.	 CD: Compact Disc
	 4.	 DVD: Digital Versatile Disc
	 5.	 BDA: Blu-ray Disc Association
	 6.	 SMPS: Switch Mode Power Supply
	 7.	 CAM: Computer-Aided Manufacturing
	 8.	 CAD: Computer-Aided Design
E.	 1.	 Mobile OS: Android and Apple iOS 
	 2.	 Linux Distribution: Red Hat and Ubuntu 
	 3.	 GUI Based OS:  Ubuntu and Microsoft Windows 10 
	 4. 	eal-time OS:  Automated Teller Machines (ATM) or traffic signal control systems.

Section B 
(Subjective Type Questions)

A.	 1.	 Some characteristics of a computer are as follows:
	 	 •	 �Speed: The computer processes data at an extremely fast rate. It can execute millions of 

instructions in a second. 
	 	 •	 �Accuracy: Besides the efficiency, the computer performs its tasks very accurately. It 

performs calculations without making mistakes and produces information based on the 
data entered. 

	 	 •	 �Reliability: A computer is a reliable device; it does not fail to produce a result. It calculates 
exactly as per the instructions given to it. It can work even in places where human beings 
cannot. 

	 	 •	 �Versatility: A computer is versatile in nature, i.e., it can work on various kinds of inputs 
and can produce multiple kinds of outputs like sound, graphics, text, animations, etc. 

	 	 •	 �Storage Capacity: Computers can store large amounts of data and can recall the required 
information almost simultaneously. 

	 2.	 The following are some of the limitations of a computer:
	 	 •	 A computer can only perform what it is instructed or programmed to do.



3Touchpad Information Technology-XI (Answer Key)

	 	 •	 �The computer needs well-defined instructions to perform any operation. Hence, computers 
are unable to give any conclusion without going through any intermediate steps.

	 	 •	 A computer’s use is limited in areas where qualitative considerations are important. 
	 3.	 Following figure shows the block diagram of a computer:

Control Unit (CU)

Input Output

Block Diagram of Computer System

Arithmetic
Logic Unit

Central Processing Unit

Main Memory

Auxiliary Storage
mouse, keyboard monitor, printer

Control Flow
Data Flow

	 4.	 CPU takes information from the input unit or memory and processes it as per the given 
instructions. 

	 5.	 An operating system is a collection of system programs that together control the operation 
of a computer system. It acts as an intermediary between a user and the computer hardware.

	 6.	 (The question is printed incorrect in the book. Please correct it in your textbook.)
		  Question:  How many types can an operating system be classified based on number of users? 
	 Ans.	 On the basis of number of users, OS can be classified into following types: 
	 	 •	 Single User System 
	 	 •	 Multi-User System 
	 7.	 Troubleshooting is a form of problem-solving, often applied to repair failed products or 

processes on a machine or a system. 
	 8.	 The basic troubleshooting steps that you should keep in mind are as follows:
	 	 •	 �Check the Cables and Power Cord: If a piece of computer hardware isn’t working, check 

the cables. Make sure the power cord is properly plugged and the power button for these 
devices is turned ON. In case of wireless devices, ensure that the batteries is charged and 
properly paired. 

	 	 •	 �Use Help: By using the F1 key, you can open the Help window. This window assists in 
identifying a solution to the issue. 
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	 	 •	 Record Error Messages: For future reference, keep a record of the entire error message. 
	 	 •	 �Restart the Computer: Restart the computer system a simple restart can resolve many 

software-related issues. Rebooting the computer can refresh system settings and clear 
temporary glitches. 

	 9.	 To change the default printer: 
	 	 •	 Click on the Start button. 
	 	 •	 Go to Control Panel and choose the Hardware and Sound option. 
	 	 •	 Select Devices and Printers. 
			�   The screen below shows the default printer. There is a tick inside a small green circle next 

to its icon (this signifies that it is the default printer). 
	 	 •	 Right-click on the icon for this printer and a pop-up menu is displayed. 
	 	 •	 �Select Set as default printer from this pop-up menu. The tick next to the icon shows that 

it is now the default printer.
	 10.	 To check the internet connection, view the Network icon present on the Task Bar (bottom 

right of the screen).  
		  Another method to check for network connectivity is: 
	 	 •	 Click on the Start button. 
	 	 •	 Go to Control Panel. 
	 	 •	 Go to Network and Internet. Select Network and Sharing Centre. 
	 	 	 �The message under ‘View your active networks’ indicates that the computer is not 

connected to the Internet. 
	 11.	 �RAM is a volatile memory, i.e., when a computer is switched ‘OFF’ or the power supply is 

interrupted, all the stored information in it disappears or is lost.
	 12.	 The OS considered as a platform for application programs because it provides a set of 

essential services and functionalities that help users to perform specific tasks effectively and 
efficiently on a computer system. 

B.	 1.	 Cache memory is a chip that serves as a high-speed buffer between the CPU and RAM, 
which aims to reduce the average time to access data from the main memory. The cache 
is a smaller and faster memory that stores copies of the data from frequently used main 
memory locations.

	 2.	 The motherboard is the main circuit board of a computer that lies inside the system unit 
through which all the hardware is connected. It is in the form of a large multilayered printed 
circuit which contains connectors (sockets) for attaching additional devices. 

		  Typically, a motherboard contains slots for the processor, BIOS, ROM chip, CMOS setup, mass 
storage interfaces, serial and parallel ports, expansion slots, and all the controllers required 
for standard peripheral devices like monitors, keyboards, disc drives, etc.
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	 3.	 Flash memory is also known as a memory card or SD card (Secure Digital Card), which is a 
small-sized external storage device that is commonly used in digital cameras, mobile phones, 
MP3 players, etc. that allows us to save and delete information. It can be plugged into the 
USB or Firewire port of a computer to fetch or transfer data to the computer. 

		  Pen/Flash Drive is small in size, handy, and is a detachable device from which data can be 
read, copied, or transferred from one system to another. It is re-writable and weighs less 
than 25 gm. 

		  Nowadays, pen drives are the most commonly used external storage and data transfer 
devices. It has an attachment slot that can be easily inserted or attached to the computer’s 
USB (Universal Serial Bus) port. 

	 4.	

CUI GUI

In the CUI operating system, the user 
sends commands and instructions to the 
computer in character form, i.e., by typing 
commands at the command prompt.

In this operating system, the user interface is 
graphical, i.e., the user interacts with figures 
and graphs on the screen. It is basically 
menu-based or button-based. A user can use 
the options in the menu to execute different 
functions. 

The display on the screen does not contain 
any graphics or pictures, but only a line or 
character.

GUI operating systems are interactive and 
user-friendly.

Examples are PC-DOS, MS-DOS, and UNIX.
Examples are Windows XP, Windows Vista, 
Windows 7, Windows 8, Windows 8.1, and 
LINUX (Red Hat, Ubuntu, BOSS, etc.).

	 5.	 Some of the features of the Microsoft Windows operating system are as follows: 
	 	 •	 It is a user-friendly operating system. 
	 	 •	 �It provides a ‘Multi-tasking’ feature that means many applications can be open at the 

same point in time. 
	 	 •	 It is available in GUI (Graphical User Interface) form. 
	 	 •	 It is network-friendly, i.e., it provides easy access to the internet and LAN. 
	 	 •	 Using and removing peripheral devices can be done easily in Windows. 
	 	 •	 It supports the latest graphics, sound, and multimedia software to run on itself. 
	 	 •	 It is portable and compatible, reliable and seldom crashes. 
	 6.	 If the network card is not working properly, you need to first check whether the fly lead is 

plugged into the correct network card. If the machine has more than one network card, you 
need to ensure that the cable is plugged into the network card configured for it. 
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		  To check whether the network card is working open a command prompt window: 
		  i.	 Press the Windows + R keys in combination to open Run window. 
		  ii.	 Type CMD in the Run window. 
			   An MS-DOS window will open, 
		  iii.	 Type ping 127.0.0.1 at the command prompt. 
		  iv.	 Press Enter. This will run the ping command in the command prompt window.
		  If there is no reply when you ping, contact a Service Engineer Network Administrator.
	 7.	 Sometimes computers become totally unresponsive or freeze. In this situation, computer 

system will prevent you from clicking anywhere on the screen, using any application, closing 
any application, or accessing shut-down options. 

		  You would have to force the system to shut down in this situation. For this, you need to 
press and hold the Power button of the computer system.

	 8.	 Sometimes there are multiple printers on a network. In such situation, a possible problem 
could be that a print job is being sent to a wrong printer. This is because your system has 
set the default printer. For example, if you set Printer A as a default printer, but you had 
actually wanted the print job to go to Printer B. You could either change the default printer 
to Printer B or choose Printer B for the current job.

	 9.	 What would you do when your keyboard or mouse is not responding/working properly? 
		  If your keyboard is not responding/working properly, then you need to perform the following 

steps to troubleshoot the problem:
	 	 •	 �Check Connections: Check the keyboard’s connection to the computer. If it is not 

connected, or if the connection is loose, connect it properly to the computer. 
	 	 •	 �Check for any damage: Make sure the keyboard cord is free of damage. The keyboard 

may need to be repaired or replaced if any damage is discovered. 
	 	 •	 �Keys are stuck: You need to clean the keyboard if any keys are stuck on it. Dust should 

be removed using a brush, and the keyboard should be cleaned with a moist cloth.
		  If your keyboard is not responding/working properly, then you need to perform the following 

steps to troubleshoot the problem:
	 	 •	 Check Connections: Ensure that the mouse is properly plugged into the CPU socket. 
	 	 •	 �Check for any Damage: Check the mouse cord for any damage. If there is any damage, 

then the mouse may need to be changed. 
	 	 •	 �Check the Cordless Mouse: If a cordless mouse isn’t working, turn it off and then on 

again. This should re-establish a connection with the system. 
	 	 •	 �Clean the Mouse: Clean the mouse with a damp moist. Clean the surface surrounding 

the mouse’s base button. 



7Touchpad Information Technology-XI (Answer Key)

	 10.	 Arithmetic Logic Unit (ALU)
		  ALU performs the arithmetic and logical operations on the stored numbers. ALU performs 

mathematical calculations (addition, subtraction, division, multiplication) and logical 
comparisons (greater than (>), less than (<), equal to (=), not equal to (!=)). ‘Logical operation’ 
refers to comparison and it sets the sequence of operations. It differentiates between ‘true’ and 
‘false.’ The data is transferred from the memory unit to the arithmetic logic unit, processed, 
and returned to internal storage. Finally, the results are transferred from internal storage to 
an output device. 

		  Control Unit (CU) 
		  The Control Unit checks the correctness of the sequence of operations. It coordinates and 

directs the operation of the hardware devices. It also coordinates the flow and execution of 
the data and instructions that are fed into the computer’s memory. CU functions in an F-D-E-S 
(Fetch-Decode-Execute-Store) cycle. It fetches the instructions and data from the memory 
unit, decodes them, and passes them to the ALU for further processing. It also directs the 
ALU to execute the instruction and perform the required operations on the data.

	 11.	 An operating system has a variety of functions to perform. Some of them are discusses as 
follows:

	 	 •	 �Memory Management: It manages the Primary Memory or MAIN Memory. It is the 
process of c�oordinating and controlling the use of memory in a computer system. 

	 	 •	 �File Management: The OS performs the functions of retrieving, storing, renaming, and 
protecting files. 

	 	 •	 �I/O Device Management: It controls the different input-output devices. It acts as a 
controller program as it controls the various peripherals attached to the computer system. 

	 	 •	 �Error Detection: The OS should be aware of the possible errors. Errors may occur in 
the CPU, memory hardware (memory error, power failure), errors in the I/O device (lack 
of paper in the printer), and programming errors (such as an attempt to access illegal 
memory, arithmetic overflow). 

	 	 •	 �Communication: It assists in inter-process communication through message passing or 
shared memory techniques. Here, packets of information are moved between processes 
by the OS.

	 	 •	 �Resource allocation: When multiple users are logged on to the system, resources must 
be allocated to each program (such as file storage, main memory, and CPU cycles). 

	 	 •	 �Accounting: OS helps in keeping track of how many users have logged in and what 
computer resources are used by them. 

	 	 •	 �Protection: It provides security to the system against unauthorised access. It provides 
the facility of giving protection to the data using passwords. It protects I/O devices such 
as modems, network adapters, etc. 
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	 12.	 i.	� Stylus: A stylus is a pen-shaped handheld pointing device that is used on touch screen 
devices (PDAs, smartphones, and tablets) to type, draw, and input commands into the 
device. A stylus is the primary input device for PDAs. 

			�   Trackball: A trackball is a pointing device that resembles a ball nestled in a square cradle 
and serves as an alternative to a mouse. It has a ball, which can be rotated by fingers in 
any direction, and the cursor moves accordingly. This pointing device comes in different 
shapes and forms (a ball, button, and square) but with the same function. 

		  ii.	� Impact Printer: An impact printer prints the contents by striking the printer head, or 
needle, on an ink ribbon that rolls through the cartridge to make a mark on the paper. 
Impact Printer can be classified into: 

	 	 •	 Dot Matrix Printer 
	 	 •	 Line Printer 
	 	 •	 Character Printer 
			�   Non-Impact Printer: A non-impact printer prints the output without touching or striking 

the ribbon on paper or film. This kind of printer prints by using thermal, chemical, 
electrostatic, laser beam, or inkjet technology. Usually, a non-impact printer has greater 
resolution and is faster as compared to an impact printer. Non-impact printers can print 
colourful content too. Non-impact Printers can be classified into:

	 	 •	 Ink-Jet Printer 
	 	 •	 Laser Printer
		  iii.	 (The question is printed incorrect in the book. Please correct it in your textbook.)
			   Question:  Microcomputers and Supercomputers
	 Ans.	 Microcomputers
		  A microcomputer is meant for a personal or single user. It is a small-sized computer that has 

a microprocessor chip as its CPU. Microcomputers are comparatively common, economical, 
and easier to use. Operating systems like DOS, MS-Windows, Linux, MAC OS, etc. easily run 
on such types of computers. 

		  Supercomputers 
		  Supercomputers are the largest and fastest of all types of computers. Even some 

supercomputers require much space as that of a floor of a building. The cost of a 
supercomputer is very high. They can process a very large amount of data quickly. PARAM 
was India’s first supercomputer developed in 1991. Some other examples of supercomputers 
are PACE, Titan, Sunway TaihuLight, Pratyush, Mihir, etc.

		  iv.	� Primary Memory: Primary Memory is also known as ‘Main Memory’. It stores the data 
and instructions that are meant for current processing or the internal management of 
the computer. It has a limited capacity for the storage of data. 

			   Primary Memory can be classified into two groups: 
	 	 	 •	 Random Access Memory (RAM) 
	 	 	 •	 Read Only Memory (ROM)
			�   Secondary Memory: Secondary memory refers to the permanent storage of data. It 

stores data that are permanent and can be retrieved as and when required. It has a higher 
storage capacity than the primary memory. There are various types of secondary storage 
devices.

	 	 	 •	 Magnetic Disc
	 	 	 •	 Optical Disc 
	 	 	 •	 Flash Memory
C.    Competency-based/Application-based questions:	
	 1.	 Solaris
	 2.	 Apple iOS
	 3.	 When you are not getting sound from the speakers, you need to troubleshoot this problem 

by using the following suggestions: 
	 	 •	 �Check the volume level of the speakers: Click the Volume button in the Taskbar to 

switch on the sound and sets the volume. 
	 	 •	 �Check the Cables: If you use external speakers, make sure they are plugged into the 

correct electric socket, turned on, and connected to the correct audio port or a USB port 
on your system. If your computer has color-coded ports, the audio output port will usually 
be green.

`	 Networking and Internet

Unsolved Exercise

Section A  
(Objective Type Questions)

A.	 1.	 iii	 2.	 i	 3.	 i	 4.	 iii	 5.	 iii
	 6.	 i	 7.	 i	 8.	 i	
	 9.	 . (The options of this question was printed incorrectly in the book. Please correct it in your 

textbook.)
		  Question:  Which of the following is not a wireless connection?
		  i.	 Satellite 		 ii.	 Broadband
		  iii.	 Infrared  		 iv.	 Wi-fi
	 Ans.	 ii.	 Broadband

2.
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			   Primary Memory can be classified into two groups: 
	 	 	 •	 Random Access Memory (RAM) 
	 	 	 •	 Read Only Memory (ROM)
			�   Secondary Memory: Secondary memory refers to the permanent storage of data. It 

stores data that are permanent and can be retrieved as and when required. It has a higher 
storage capacity than the primary memory. There are various types of secondary storage 
devices.

	 	 	 •	 Magnetic Disc
	 	 	 •	 Optical Disc 
	 	 	 •	 Flash Memory
C.    Competency-based/Application-based questions:	
	 1.	 Solaris
	 2.	 Apple iOS
	 3.	 When you are not getting sound from the speakers, you need to troubleshoot this problem 

by using the following suggestions: 
	 	 •	 �Check the volume level of the speakers: Click the Volume button in the Taskbar to 

switch on the sound and sets the volume. 
	 	 •	 �Check the Cables: If you use external speakers, make sure they are plugged into the 

correct electric socket, turned on, and connected to the correct audio port or a USB port 
on your system. If your computer has color-coded ports, the audio output port will usually 
be green.

`	 Networking and Internet

Unsolved Exercise

Section A  
(Objective Type Questions)

A.	 1.	 iii	 2.	 i	 3.	 i	 4.	 iii	 5.	 iii
	 6.	 i	 7.	 i	 8.	 i	
	 9.	 . (The options of this question was printed incorrectly in the book. Please correct it in your 

textbook.)
		  Question:  Which of the following is not a wireless connection?
		  i.	 Satellite 		 ii.	 Broadband
		  iii.	 Infrared  		 iv.	 Wi-fi
	 Ans.	 ii.	 Broadband

2.
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	 10.	 iii	 11.	 iii	 12.	 iii	 13.	 i	 14.	 iii	
B.	 1.	 software / hardware	 2.	 Communication 		 3.	 nodes 
	 4.	 Smising 			   5.	 credit card fraud 	 6.	 Teleconferencing 
	 7.	 e-commerce, or electronic-commerce 			   8.	 hyperlinks 
	 9.	 Point-to-Point 	 10.	 Hardware 			   11.	 Active hubs / Passive hubs 
	 12.	 gateway 			   13.	 malware 			   14.	 Spammer 
	 15.	 time bombs 		 16.	 spyware
C.	 1.	 True	 2.	 False	 3.	 True	 4.	 False	 5.	 True

Section B 
(Subjective Type Questions)

A.	 1.	 A computer network is an interconnection of two or more computers or computing devices. 
Such interconnection allows computers to share data and resources with each other. 

	 2.	 Different components of the network are nodes, switches, routers, gateways, Network 
Interface Cards (NICs), cables and connectors, firewalls, servers, modems, etc.

	 3.	 Two disadvantages of a star topology are:
	 	 •	 �Difficult to expand: The addition of a new node to a star topology network involves a 

connection all the way to the central node. Problems can arise if a longer cable length 
is needed or an unanticipated concentration of nodes is required. 

	 	 •	 �Central node dependency: The entire network becomes inoperable if the central node 
fails. 

	 4.	 An IP address is a unique identification number assigned to each computer on a network.
	 5.	 HTTPS (Hypertext Transfer Protocol Secure) is an extension of the HTTP protocol that provides 

secure communication between the client and server.
	 6.	 An FTP client is an application that is used to implement FTP, which enables the transfer 

of files between two hosts. It allows a client to connect to an FTP server and allows the 
downloading or uploading of files. 

	 7.	 Channel is a communication medium, the path that transmits data from source to destination.
	 8.	 Netiquettes refers to the correct way of conducting yourself while communicating online. 

Netiquette is the short form for Internet etiquette.
	 9.	 A switch is a hardware device used to connect multiple devices. It uses a MAC address to 

send data packets to a particular address.
	 10.	 A virus is a software code that may harm your system by overwriting or corrupting system 

files. A computer virus is similar in action to viruses in our body which replicates themselves 
and affect body cells.
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	 11.	 Cyber laws offer different ways to protect people and prevent any identity theft and financial 
crimes that happen online. 

	 12.	 A denial-of-service attack (DoS attack) is an intentional cyber-attack in which the attacker 
attacks the network, website, or online resources to restrict legitimate users to use it. It is an 
attack that is meant to make a network resource unavailable to users. 

	 13.	 Telnet provides an interactive communication service that is text-oriented, i.e., text-based 
commands are used. This communication is also two-directional.  

		  The computer that initiates a connection is known as the local computer. The computer which 
is being connected to, i.e., the one which accepts the connection, is known as the remote 
computer. During a Telnet operation, whatever is being performed on the remote computer 
will be displayed on the local computer. The local computer will make use of a telnet client 
program and the remote computer will make use of a telnet server program.

		  In telnet, there are two types of login. 
	 	 •	 Local Login: Local login occurs when the user logs in to a local computer. 
	 	 •	 �Remote Login: Remote login occurs when the user wants to access any application that 

is present on the remote computer. 
	 14.	 Internet is a worldwide system of computer networks, i.e., a network of networks, that allows 

users to share information on different devices from anywhere in the world.
B.	 1.	 There are a number of factors that should be considered before choosing the topology. 

Some of them are: 
	 	 •	 �Scalability: Consider the scalability requirements of the network. Will the network 

need to accommodate future growth in terms of the number of devices or users? Some 
topologies, such as star or mesh, may be more scalable than others.

	 	 •	 �Cost: Evaluate the cost implications of deploying and maintaining the network.  In terms 
of pricing, bus and ring topologies are cost-effective in compare to star, mesh, tree, and 
hybrid topologies.

	 	 •	 �Reliability: The topology chosen for the network can help by allowing the location of 
the fault to be detected and providing some means of isolating it. 

	 	 •	 �Flexibility: Think about the network’s versatility and adaptability. What kinds of devices, 
apps, or protocols will the network need to support? A topology’s ability to adjust and 
change with 

	 	 •	 �Ease of management: Evaluate the ease of management and administration of the 
network. Some topologies may be easier to manage and troubleshoot than others, 
especially in large-scale deployments. 

	 	 •	 �Physical Constraints: Always consider the physical constraints or limitations, such as 
the layout of the building or facility, the distance between devices, and environmental 
factors.
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	 2.	 i.	 LAN and MAN

LAN MAN
LAN is a group of computers connected 
to each other in a small area such as office 
building through ethernet cables/ co-axial 
cables, etc.

MAN is a type of network in which the 
computers are connected over a large 
geographical area such as a city.

LAN is useful for sharing resources like files, 
printers, games, or other applications.

It is mainly owned by large organizations to 
interconnect all its branches across a city. 

LAN uses guided media. LAN uses both guided and unguided media.

		  ii.	 Guided and Unguided transmission media. 			 

Guided Transmission Media Unguided Transmission Media
Guided transmission media use a cabling 
system that guides the data signals along a 
specific path.

Unguided transmission media transfer data 
signals through the air.

The data signed in the guided medium is 
bound by the cabling system.

They are not guided or bound to a fixed 
channel to follow.

Examples of guided media are: Ethernet 
Cable, Co-Axial Cable, Optical Fiber Cable, 
etc.

Examples of unguided media are: Radiowave 
(Bluetooth, Wi-Fi, etc.), Microwave (Mobile/ 
Cellular Communication, Satellite, etc., 
Infrared (T.V. Remote Control, Motion Sensor 
device, etc.)

	 	 iii.	 Bluetooth and Wi-Fi 

Bluetooth Wi-Fi
It is wireless network connectivity that 
enables us to connect or transfer data 
between devices over a short-range.

Wi-Fi is used for wireless networking over a 
larger area, typically covering a home, office, or 
public space and provides internet connectivity 
to devices within its coverage area.

Bluetooth is mostly utilised for mobile 
phones, laptops, personal computers, 
printers.

Wi-Fi is utilised for accessing the internet.

Bluetooth consumes low power. Wi-Fi consumes high power.

	 iv.	 Bus and Star Topology

Bus Topology Star Topology
Each node is connected to the backbone 
cable or drop cable.

Computers or other devices are connected via  
central hub or switch.
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Uses a single main cable (the bus) to which 
all devices are connected.

Use separate cable for connecting each 
device to the central hub or switch.

When a message or data is sent over the 
network, it is received by all nodes that are 
connected to the network.

The hub acts as a central controller and if a 
node wants to send data to another node, 
it can send the same through the hub only.

	 v.	 MAN and WAN

MAN WAN
MAN is a type of network in which the 
computers are connected over a large 
geographical area such as a city.

WAN spans a large geographical area, often 
a country. 

It uses guided as well as unguided media. It uses unguided media.

It may be a single network or may be a 
network that connects several LANs.

This type of network spans large geographical 
areas and uses a variety of commercial and 
private communication lines to connect 
computers.

	 3.	 A search engine is a complex program that searches documents, websites, etc., containing 
a specified set of keywords. A search engine basically works in three phases: 

		  i.	� The search engine sends a program called the spider that searches the different web 
pages or documents on the Internet for the keyword. 

		  ii.	� After the spider fetches the result, another software called the indexer reads these results. 
The indexer then creates an index based on the words contained in each of the documents 
returned by the spider. 

		  iii.	� After indexing, the search engine presents only the documents or websites that match the 
search criteria to the user. The relevant results are shown by the search engine depending 
upon how you frame the query. 

	 4.	 Some of the advantages of FTP are as follows: 
	 	 •	 �Efficiency: This protocol is highly efficient in working as the users do not need to wait 

for the completion of the entire process to get the requested file. 
	 	 •	 Speed: FTP is one of the fastest protocols used for file transfer. 
	 	 •	 �Security: The client must first log in with a username and password (hostname and IP 

address). 
	 	 •	 �Two-way communication is possible: FTP allows clients to receive files from the server 

and also send files to the server. 
	 5.	 The advantages of repeaters are:
	 	 •	 Repeaters are easy to install and increase the length of coverage area. 
	 	 •	 They are economical. 
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	 	 •	 Processing overhead is negligible. 
		  The disadvantages of repeaters are:
	 	 •	 They cannot connect dissimilar networks. 
	 	 •	 They are incapable of reducing network traffic and congestion. 
	 	 •	 They can’t differentiate between actual signal and noise. 
	 6.	 URL, or Uniform Resource Locator, is a unique identifier used to locate a resource on the 

internet. It identifies the location of a website or a web page on the internet. The format of 
a URL consists of different parts. 

		  For example: 	http://www.onlineexammica.in/home/main.htm. 
		  The structure of this URL is: 
		  Protocol: http 
		  Domain Name: onlineexammica 
		  Top-level domain: .in 
		  Path: home 
			   File name: main.htm 
	 7.	 To avoid falling victim to phishing attacks, you need to adhere the following preventive 

measures 
	 	 •	 Verify the sender’s email address carefully for any suspicious or misspelled domain names. 
	 	 •	 �Hover your cursor over the hyperlinked URL/text/image but don’t click. Check if the 

address matches the one written in the message.
	 	 •	 �Install and regularly update antivirus, anti-malware, and anti-phishing software on your 

devices. 
	 	 •	 �Educate yourself and others about common phishing techniques and strategies employed 

by online fraudsters.
	 8.	 Cybercrimes are crimes that involve the computer or internet. They may be related to the 

misuse of computers or the Internet such as theft, fraud, and forgery. The IT act defines 
cybercrime as “an unlawful act wherein the computer is either a tool or a target or both”.

		  Some of these crimes are mentioned below: 
	 	 •	 �Stealing someone’s personal information like Customer ID, net banking password, ATM 

Pin, OTP, card expiry details, CVV, etc. through phishing. 
	 	 •	 Sending spam emails to uninterested recipients. 
	 	 •	 Forging someone’s digital signatures 
	 	 •	 Harassing or bullying someone through emails, messages, or social networking. 
	 	 •	 Hacking someone’s social media account or bank account. 
	 	 •	 �Providing misleading information to clients/ general public through the use of Internet 

resources. 
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	 	 •	 Posting offensive content on any site or sending it to anyone. 
	 9.	 A firewall aims at protecting the internal network of an organization, home, or individual 

from malicious traffic from external networks. The firewall inspects the network traffic and 
allows only those, that do not violate the security constraint to pass through the network. 
Hardware firewalls in the form of a router prevent malicious software from entering the 
internal network from outside. However, software firewalls installed on personal computers 
prevent unauthorised access or malware from gaining access to personal computers. 

	 10.	 Based upon geographical area, the network can be divided into the following categories:
	 	 •	 �LAN (Local Area Network): LAN is a group of computers connected to each other in a 

small area such as office building through ethernet cables/ co-axial cables, etc. They are 
widely used in office building, school, or home. A LAN is useful for sharing resources like 
files, printers, games, or other applications.

	 	 •	 �MAN (Metropolitan Area Network): MAN is a type of network in which the computers 
are connected over a large geographical area such as a city. It may be a single network 
or may be a network that connects several LANs. 

	 	 •	 �WAN (Wide Area Network): WAN spans a large geographical area, often a country. This 
type of network spans large geographical areas and uses a variety of commercial and 
private communication lines to connect computers. Its purpose is to establish connections 
to share information among computers from one place to other globally.

	 	 •	 �VAN (Value Added Network): A value-added network (VAN) is a private, hosted 
service that provides companies with a secure way to send and share data with their 
counterparties. 

	 	 •	 �PAN (Personal Area Network): PANs are used for communication among devices within 
the personal space of an individual, typically within a range of a few meters.

	 	 •	 �CAN (Campus Area Network): A Campus Area Network (CAN) is a computer network 
that spans a small geographical area like a school campus, university campus, military 
base, organizational campus, corporate building, etc. CANs interconnect multiple local 
area networks (LAN) within an educational or corporate campus.

C.    Competency-based/Application-based questions:	
	 1.	 Hybrid Topology
	 2.	 i.	 A suitable topology for networking the computers of all wings would be a Star topology.
		  ii.	� The server should be installed in the Administration (A) wing. Because, the Administration 

wing is centrally located among all other wings. Placing the server in the Administration 
wing ensures relatively equal access time for all departments, minimizing network latency 
and optimizing performance. 

		  iii.	� Each wing will have a switch connecting all the computers within that wing. This switch 
will then be connected to a central switch located in the Administration wing (where the 
server is). This central switch will act as the backbone for the entire network.
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	 3.	 Swati can use the Hypertext Transfer Protocol (HTTP) to upload hypertext documents on the 
internet.

	 4.	 The most likely reason behind someone being able to access your friend’s Gmail account 
after she left the computer lab, despite her ensuring that the account was not left open, 
is that the browser’s cache or cookies saved her login credentials. To stop such types of 
occurrences, it is essential to log out the email account, do not save passwords, and delete 
browsing history from shared computers.

	 5.	 Under such circumstances, I would move cautiously and implement the following measures: 
	 	 •	 �Confirm that the email is received from my bank’s official domain by looking up the 

sender’s address. 
	 	 •	 �Rather than of clicking on the link provided in the email, I would independently navigate 

to my bank’s official website by typing the URL directly into the browser or using a 
bookmarked link.

	 	 •	 �Contact the bank directly through their official customer service channels to inquire about 
the email and verify if there are any issues with my account.

	 	 •	 �Report suspicious emails to the relevant authorities or the bank’s security staff for further 
investigation.

	Office Automation Tools

Unsolved Exercise

Section A  
(Objective Type Questions)

A.	 1.	 iv	 2.	 iii	 3.	 ii	 4.	 ii	 5.	 ii	 6.	 ii	
	 7.	 iii	 8.	 ii	 9.	 i	 10.	 iii	 11.	 i	 12.	 ii	
	 13.	 iv	 14.	 i	 15.	 iv	 16.	 ii	 17.	 iv	 18.	 i
	 19.	 ii	 20.	 iii	 21.	 iv	 22.	 iv	 23.	 ii	 24.	 iv
	 25.	 iv	
B.	 1.	 AutoCorrect		  2.	 Page Preview	3.	 .odt	 4.	 Pair kerning
	 5.	 Formatting			  6.	 cell address	 7.	 Navigation	 8.	 Alphanumeric
	 9.	 splitting			   10.	 .ods	 11.	 Compare Document
	 12.	 two			   13.	 bar chart	 14.	 Stop Recording
	 15.	 Motion Paths	 16.	 35mm	 17.	 Slide Show
	 18.	 Promote/Demote	 19.	 375	 20.	 Slide Sorter
	 21.	 Home			   22.	 View	 23.	 End	 24.	 Slide transition

3.
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C.	 1.	 True 	 2.	 True	 3.	 True	 4.	 False	 5.	 False

Section B 
(Subjective Type Questions)

A.	 1.	 Different components of the main screen of OpenOffice Writer are: 
	 	 •	 Document Window/Work Area 
	 	 •	 Title Bar 
	 	 •	 Minimize/Maximize/Restore/Close Buttons 
	 	 •	 Menu Bar 
	 	 •	 Standard Toolbar 
	 	 •	 Formatting Toolbar 
	 	 •	 Ruler 
	 	 •	 Status Bar 
	 	 •	 Scroll Bars (Horizontal & Vertical) 
	 	 •	 Previous Page/Next Page Button 
	 2.	 In Impress, the display grid command toggles the visibility of a grid overlay on the slide. 

This grid allows users to align objects and elements more accurately on slides. 
	 3.	 An Indent is the space (gap) of text (a line or paragraph) from the edge/margin. Margin is 

the gap between the edge and the beginning of the text, i.e., the outer boundary of the text 
in a document beyond which the contents of the document do not flow.

		  The margin settings are applied to the whole document or the text area, while indentation 
sets the space of a paragraph from the margin with respect to the rest of the text that is 
below or above it.

	 4.	 To print a series of months of the year, follow the given steps:

		  1 	 Type the initial data (month name) of the series in one cell.

		  2 	� Select the cell. An AutoFill handle (a small black plus sign) appears at the bottom-right 
corner of the selected cell.

		  3 	� Click the AutoFill handle and drag it over the range of cells to fill the defined series, 
then release the mouse button. The series of months gets displayed on the spreadsheet.

	 5. 	Relative Referencing: 	In Relative referencing, the cells are identified by their address in the 
worksheet in relation to the cell where the formula is entered. 

		  Absolute Referencing: 	Absolute referencing is the way to apply a formula in which the 
Cell addresses or the value of a range of cells do not change even if the formula is copied 
to a new cell. To apply an Absolute cell referencing, a $ (dollar) sign is put before the Row 
number and/or Column name in the cell address. 
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	 6.	 Following steps are performed to apply AutoFilter: 

		  1 	 Select the column you want to filter. 

		  2 	 Select Data→ Filter→ AutoFilter option. 
			�   When you click the AutoFilter option, a combo box will appear in the selected column 

header. 

		  3 	� Click the drop-down arrow and choose the value to filter the column.
			   Based on the selected value, data in the columns will be filtered.
	 7.	 Elements of a chart are as follows:
	 	 •	 Plot Area: It is that area of the chart in which the data is plotted.
	 	 •	 Chart Title: It is the heading text that helps to identify the chart.
	 	 •	 Axis Titles: It refers to the titles given to the three axis, i.e. X, Y and Z axis.
	 	 •	 �Legend: It helps to identify the plotted data series. Unique colour or pattern is helpful 

to identify such series.
	 	 •	 �Data Label: It refers to the label that provides additional information about the data 

marker, thus representing a single data item or value of a cell.
	 8.	 The software that is used to organize and display information through text, pictures, figures, 

etc. is known as Graphical Presentation package. Presentation packages can be divided into 
different categories depending upon the areas of usage. A presentation package helps to 
create and display an eye-catching and systematic visual show with the help of slides.

	 9.	 A user can design a presentation by using following ways:
	 	 •	 Empty presentation
	 	 •	 From template
	 	 •	 Open existing presentation
	 10.	 To insert slide numbers, follow the given steps:

		  1 	 Place the text holder on the slide where the slide number is to appear.

		  2 	� Click on the Insert menu and click on the Page Number option. The Header and 
Footer dialog box appears.

		  3 	 Click on the Slide number checkbox.

		  4 	 Click on the Apply  button to insert the page number to the selected slide.

		  5 	� Click on the Apply to All button to insert slide numbers to all the slides of the 
presentation.

	 11.	 The Find and Replace option of the word processor facilitates finding or searching for a 
specified word, phrase or text that is present in a document and replacing the searched text 
with the new text. 

	 12.	 Each cell in a worksheet has a unique address that identifies its location. A cell address is 
identified with its column position followed by its row number, for example: ‘A5’ is the cell 
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address that is a combination of column ‘A’ and row ‘5’.
B.	 1.	 A word processing package is a kind of software that provides page layout and enables you 

to type text and create documents. Some features of word processing package are:
	 	 •	 It enables editing (insert, delete, and replace) text and objects, 
	 	 •	 It allows formatting the document to increase readability and appearance, 
	 	 •	 It prints a copy of the document
	 	 •	 It allows to save the document for future use or reference.
	 2.	 i.	� A Header is the repetitive text that is printed at the top of every page, whereas a footer 

is the repetitive text that is printed at the bottom of every page in a document 
		  ii.	 Copying text and moving text:
	 	 •	 �Copying text means duplication of selected text in a document so that it can be used 

somewhere else. A user can use the Copy and Paste option to copy existing text from 
one location in a document and then paste it to another location.

	 	 •	 �Moving text means move the document to other location. The Cut option helps you to 
remove or cut the selected text from its original place. It can then be pasted in the same 
place or new place in the same or another document.

		  iii.	� The Save As option helps you to save a document with a new name or make a copy of 
an existing document with the same file name in a different location. 

		  The Save option save an existing document.
	 3.	 Some of the formatting features provided by the spreadsheet are:
	 	 •	 �Styles and Formatting: It contains some pre-defined style of text (font size, font type, 

text color, case…etc.). Users can create styles of their own.
	 	 •	 Font name: It contains different font styles for changing text design.
	 	 •	 Font size: It allows you to change the font size.
	 	 •	 �Bold/Italic/Underline: It converts the text to bold or italic text or underlines the text 

according to the selected option.
	 	 •	 �Text alignment: It helps you to set the alignment of the line/paragraph to right, left or 

center according to the user’s choice.
	 5.	 Follow the given steps to run/use a macro that we have already created:

		  1 	� Click on Tools → Macros → Run Macros. A dialog box will open showing all the macros 
created.

		  2 	 Select the macro that you want to run and then click on the Run button.

		  3 	� The tasks performed during recording of the macro will be repeated in the same order 
in which they were performed. By default, recorded macros use absolute cell referencing, 
which means that exact cell locations are recorded into the macro.
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	 6.	 Pass-by-argument means to pass the argument in the calling function to the corresponding 
formal parameter of the called function. The called function can modify the value of the 
argument by using its reference passed in.

	 7. 	Custom animation is a feature in Impress that enables you to set timings between the 
display of the content or objects of the slides and also enables to apply different whirling 
effects to animate the object. 

		  Slide transition is a feature in Impress that enables you to set the style of display of the 
slides during the entry of the presentation. It is the effect applied when a slide changes to 
another during an on-screen presentation or slide show.

	 8.	 An electronic and digitalised way of delivering content or information is highly impressive, 
especially while conducting a conference or while giving lectures or for demonstration, is 
commonly known as a presentation. To make the presentation more effective and attractive, 
we can add pictures and media in the slides.

		  To insert a picture, follow the given steps:

		  1 	 Select the Picture option from the Insert menu.

		  2 	 Click on the From File option. The Insert picture dialog box appears.

		  3 	 Navigate the location and select the desired picture.

		  4 	 Click on the Show the preview pane button to view the picture before inserting it.

		  5 	 Click on the Open button to insert the picture.
	 9.	 To add movie or sound into the presentation:

		  1 	� Select the Movie and Sound option from the Insert menu. The Insert Movie and 
Sound dialog box appears on the screen.

		  2 	 Navigate the location and select the desired movie/sound that want to insert.

		  3 	 Click on the Open button to insert the selected movie/sound. 
	 10.	 To print a presentation, follow the given steps:

		  1 	� Select the Print option from the File menu or press Ctrl+P on the keyboard. The Print 
dialog box will appear on the screen.

		  2 	 Select the desired printer.

		  3 	 Select the range of slides to be printed.

		  4 	 Specify the number of copies.

		  5 	 Click on the Print button.
	 11.	 To insert a watermark on the slide, follow the given steps:

		  1 	 Insert the graphic (Picture, Chart, etc.) in the slide which has to be used as a watermark.
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		  2 	� Select the Watermark option from the Color mode list from Graphic section in the 
Properties pane.

	 12.	 List the steps for inserting a hyperlink to a web page in a document.� [CBSE Handbook]
		  To insert a hyperlink in your document, follow the given steps: 

		  1 	 Click on the Insert menu. A drop-down menu opens. 

		  2 	� Select the Hyperlink option from the drop-down menu. The Hyperlink dialog box 
opens. 

			   Now, on the left-hand side, select one of the four types of hyperlinks: 
	 	 	 •	 Internet: a web address, normally starting with https:// 
	 	 	 •	 Mail & News: for example, an email address. 
	 	 	 •	 �Document: the hyperlink points to another document or another place in the 

presentation. 
	 	 	 •	 New document: the hyperlink creates a new document. 

		  3 	� Suppose we are selecting the Internet type hyperlink, choose the type of hyperlink 
(choose between Web, FTP, 248 or Telnet), and enter the required web address (URL). 

			�   The Further settings section in the bottom right part of the dialog box is the same for 
all types of hyperlinks. However, some choices are more relevant to some types of links. 

	 	 •	 Set the value of Frame to determine how the hyperlink will open. 
	 	 •	 Form specifies whether the link is to be presented as text or as a button. 
	 	 •	 Text contains the text that will be visible to the user. 
	 	 •	 �Name is applicable to HTML documents. It contains text that will be added as a NAME 

attribute 	in the HTML code behind the hyperlink. 
		  iv.	  Click on Apply button.
	 13.	 List the tabs in OpenOffice Writer. What are the key tasks performed by the writer? [CBSE 

Handbook]
		  Different menus in OpenOffice Writer are: 
	 	 •	 File menu
	 	 •	 Edit menu
	 	 •	 View menu
	 	 •	 Insert menu
	 	 •	 Format menu
	 	 •	 Table menu
	 	 •	 Tools menu
	 	 •	 Window menu
	 	 •	 Help menu
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		  OpenOffice Writer allows you to insert, delete, and replace (edit) text and objects. It gives 
the facility to format the document to increase readability and appearance. It also allows 
you to print a copy of the document and saves a document for future use or reference. 

	 14.	 To insert a Chart, follow the given steps:

		  1 	 Select the data.

		  2 	 Select the Chart option from the Insert menu. The Chart Wizard will appear.
		�  The Chart Wizard dialog box appears with four steps on the left side as: Chart Type, Data 

Range, Data Series, and Chart Element.

		  3 	 Select any type of chart from Choose a chart type section.

		  4 	 Click on the Next button.

		  5 	 Enter the appropriate range of cells. (To alter the range click on the Data Range option.)

		  6 	 Select the range of cells to display the chart.

		  7 	 Click on the Next button.
		  The pointer moves to Data Series. Here the user can change the source range of all data 

series separately, including their labels along with the range of the categories.

		  8 	 Select the data range from the list for Name and Y-Values.

		  9 	 Edit data series from other cells. Chart Elements section appears on the screen.

		  10 	 Specify the title and subtitle of the chart.

		  11 	 Click on the desired check box in the Display grids section.

		  12 	 Click on the Display legend checkbox and select the desired radio button.

		  13 	 Click on the Finish button.
		  The chart will be displayed in the sheet, which can be Cut or Copied and Pasted at other 

locations.
	 15.	 The presentation can be viewed in six different modes, which are:
	 	 •	 �Normal View: In normal view (by default) a blank slide appears on the workspace. It 

enables the user to make a presentation as per the need. It is helpful while designing a 
presentation of a large number of slides. It sets the standard for viewing slides. 

	 	 •	 �Outline View: Outline View displays the slides of a presentation in the miniature format 
which is without backgrounds, colours, graphics, etc. 

	 	 •	 �Notes View: In the notes view, the slides are displayed in a reduced form on top of the 
page. Towards the bottom side, there is a text box in which notes for the slide can be 
added. 

	 	 •	 �Handout View: The handout view enables to prepare a hard copy or summary of the 
presentation. With this view, the user can print many slides on a single page. (Often the 
Handout tab is not viewed as a template).
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	 	 •	 �Slide Sorter View: In Slide Sorter View, you can view more than one slide in a small size 
on the screen. The number of slides that get accommodated on the screen depends on 
the monitor and the percentage of Zoom. The user can rearrange the order of slides 
which are numbered according to the sequence of the presentation. 

	 	 •	 �Slide Show: The Slide Show view is used to view the complete presentation and it displays 
each slide on full screen, one by one. A user can press the Home key to move to the first 
slide and the End key to move to the last slide during the slide show. To stop in between, 
the user can right-click the mouse and select the option Exit.

C.    Competency-based/Application-based questions:	
	 1.	 Rahul can use the Insert menu in OpenOffice Writer to add pictures to his document. Under 

the Insert menu, there is an option called Picture. By selecting this option, Rahul can insert 
images from his computer or other sources into his document to enhance his narrative of 
his summer holiday experience in Kashmir.

	 2.	 Imran can find the option to write algebraic formulas and functions in OpenOffice Writer by 
going to the Insert àObject à Formula option from the drop-down menu. 

	 3.	 Insha can use the Find and Replace feature to quickly correct the typo without wasting 
time. In Writer, this feature is found under the Edit menu. She can type three in the Find 
textbox and the in the Replace textbox, then click on the Replace All button to correct all 
instances at once.

	 4.	 Rakhi can utilize the Footer feature of the word processor to automatically insert her name 
at the bottom of all pages in her article. A footer is the repetitive text that is printed at the 
bottom of every page in a document.

	 5.	 Khushboo can use the Merge Cells feature to join cells into one. This option is found in the 
Table menu.

	 6.	 For comparing profit per commodity sold and net profit, a column chart or a bar chart would 
be suitable. These chart types allow for clear comparison between different categories, 
making it easy to analyse the data.

	 7.	 The Slide Show view is used to view the complete presentation and it displays each slide on 
full screen, one by one. 

		  In Slide Sorter View, you can view more than one slide in a small size on the screen. The 
number of slides that get accommodated on the screen depends on the monitor and the 
percentage of Zoom. 

	 8.	 To color the background of a text box in OpenOffice Impress, Insha can select the text box, 
go to the Format menu and then select the Area option. Now, select the colour from the 
Fill section of the Area tab in Area dialog box.
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	 9.	 To accomplish the tasks for improving the presentation: 
	 	 i.	 �Ms. Pallavi can insert the company’s logo on the first slide by selecting the Picture option 

from the Insert menu and then selecting the logo file from the computer. 
		  ii.	� She can add headers to each slide by accessing the Header and Footer option under 

the View menu. Now, she can input the relevant header text for each slide. 
		  iii.	� To add slide numbers automatically, she can again use the Header and Footer option 

under the View menu. Now, select the Slide number checkbox in the Header and Footer 
dialog box to include slide numbers. This will automatically number each slide at the 
bottom of the page.

	RDBMS

Unsolved Exercise

Section A  
(Objective Type Questions)

A.	 1. iii 	 2.	 iii 	 3.	 Iii	 4.	 iv 	 5.	 iv 	 6.	 iii	
	 7.	 iv	 8.	 iii 	 9.	 i 	 10.	 ii 	 11.	 i 	 12.	 ii 	
	 13. i	 14.	 i	 15.	 ii 	 16.	 i 	 17.	 i	 18.	 ii 	
	 19.	i 	 20.	 iii 	 21.	 iii	 22.	 i 	 23.	 i	  24.	 i
B.	 1.	 high-level interactive 	 2.	 Schools 	 3.	 CHECK 	 4.	 Propagating Update
	 5.	 The question is printed incorrect in the book. Please correct it in your textbook.)
		  Question: MySQL follows the working of ____________ architecture.
	 Ans.	 Client-Server
	 6.	 Data Control Language 	 7.	 ALTER 	 8.	 LIKE 	 9.	 blob 
	 10.	 show table 			  11.	 degree 	 12.	 UPDATE
C.	 1.	 True	 2.	 False	 3.	 True
	 4.	 The question is printed incorrect in the book. Please correct it in your textbook.)
		  Question: MySQL includes command line programs such as mysqladmin and graphical 

programs such as MySQL Workbench.
	 Ans.	 True
	 5.	 False
D.	 DDL commands:
	 1.	 CREATE

4.
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	 2. 	ALTER
	 5.	 DROP
	 DML commands:
	 3.	 INSERT
	 4.	 UPDATE
	 6.	 DELETE
	 7.	 SELECT 

Section B 
(Subjective Type Questions)

A.	 1.	 A DBMS ensures the security that only authorized users are allowed to access the data of a 
database. To operate, different users can be given separate and restricted access levels to 
the data in a database. 

	 2.	 A Data Control Language is a language that has various commands which are used to grant 
and take back authority from any database user. 

	 3.	 Database Management System (DBMS) refers to a software package that enables the users 
to store, modify and manage the database and helps to extract useful information from the 
database as and when required. 

	 4.	 Primary key 
		  A primary key is a field or column of a table that uniquely identifies each record in the table. 

The primary key can’t be duplicated. 
		  Foreign key
		  Foreign key is used to generate the relationship between the tables. It can accept null and 

duplicate values. It is a field in a database table that is the primary key in another table. It 
acts as a cross-reference between two tables as it references the primary key of another 
table. 

	 5.	 Sales: for keeping customer, purchase, sales, product information, etc. 
	 	 Schools: for keeping records about student’s details, fees paid details, marks, etc. 
	 6.	 MySQL is one of the most popular database management system software used for managing 

the relational database. It is an open-source RDBMS software that is available free of cost. 
It can run on all operating systems. 

	 7.	 Super key is an attribute (or a set of attributes) that uniquely identify a tuple i.e. an entity 
in an entity set. 

		  Alternate keys are candidate keys that do not match the Primary key. A table can only have 
one primary key. 

	 8.	 A data type defines a sort of value that a column will contain. In a database table, every 
column must have a name and data type.  Some commonly used data types are: INT, CHAR, 
FLOAT, DOUBLE.
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	 9.	 The DEFAULT constraint is used to specify a default value for a column. If no other value is 
specified, the default value will be added to all new records. 

	 10.	 The Describe statement is used to view the structure of an already created table. 
		  Syntax: DESCRIBE Table_name; 
		  The short form of DESCRIBE is DESC, by which we get a description of the table. 
	 11.	 The syntax of the ALTEr Table statement is: 
		  ALTER TABLE <Table_name> ADD/Modify/DROP attribute1, attribute2...; 
		  The ALTER TABLE statement allows you to add, modify, and delete columns from an existing 

table. This statement also allows database administrators to add and remove SQL constraints 
from existing tables. 

	 12.	 DECIMAL (size, d) data type specifies an exact fixed-point number. The total number of 
digits is specified in size. The number of digits after the decimal point is specified in the 
d parameter. The maximum number for size is 65. The maximum number for d is 30. The 
default value for size is 4. The default value for d is 0. 

	 13.	 The syntax to remove an attribute by using the ALTER command are:
		  ALTER TABLE <Table_name> DROP attribute; 
	 14.	 79 
B.	 1.	 There are several advantages of DBMS:
	 	 •	 �Reduction in Data Redundancy: Data redundancy refers to the duplication or the 

repetition of data. In a DBMS, all the data or the information are kept in one place and 
any application that requires relevant data can access it from the central location.

	 	 •	 �Reduction in Data Inconsistency: In DBMS, the stored database is consistent and remains 
updated, in case data of any item is changed i.e., when the modification is made in any 
portion of data, the changes are updated automatically at all other locations wherever 
that data has been used. This process is also known as Propagating Update.

	 	 •	 �Sharing of Data: Sharing of data means that the same data stored in one location can be 
accessed / shared by multiple users or for different applications from multiple locations. 
Sharing of data saves cost & time.

	 	 •	 �Enforcement of Data Standards: In DBMS, access to the database is done in a 
standardized and systematic manner. 24 Touchpad Information Technology-XI (Answer 
Key)

	 	 •	 �Ensure Data Security: A DBMS ensures the security that only authorized users are allowed 
to access the data of a database.

	 	 •	 �Maintenance of Data Integrity: Data integrity implies validation of data. The DBMS 
ensures that only valid data can be entered into the database.

	 	 •	 �Interactive Interface: DBMS provides a more convenient interactive interface for entering 
or viewing data.
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	 2.	 The CREATE DATABASE command is used to create a database in MySQL. The syntax to 
create a database is: 

		  CREATE DATABASE database_name; 
		  For example, CREATE DATABASE School; 
		  After creating a database, you need to access the database by using the USE command in 

the following way: 
		  USE School;	
	 3.	 Primary key 
		  A primary key is a field or column of a table that uniquely identifies each record in the table. 

The primary key can’t be duplicated, i.e., the same value can’t appear more than once in the 
table. A table cannot have more than one primary key. 

		  Candidate Key 
		  A candidate key is an attribute or set of attributes that uniquely identifies a row. Among 

the set of candidates, one candidate key is chosen as the primary key. So, a table can have 
many candidate keys but only one primary key. 

		  Alternate Key 
		  Alternate keys are candidate keys that do not match the Primary key. A table can only have 

one primary key. As a result, all of the remaining Candidate keys are referred to as Alternate 
or Secondary keys. 

		  Foreign key 
		  Foreign key is used to generate the relationship between the tables. It can accept null and 

duplicate values. It is a field in a database table that is the primary key in another table. It 
acts as a cross-reference between two tables as it references the primary key of another 
table.

	 4.	 A Relational Database Management System (RDBMS) is a database system based on the 
relational model. It is a relational DBMS in which tables are linked to each other by fields. 
The difference between the previously discussed database and relational database is in terms 
of flexibility. RDBMS is way more flexible than any other database management system. It is 
relatively easy and quick to create a new database structure and change existing structures 
in relational systems. In addition to all advantages of DBMS (as discussed), RDBMS helps in 
the management of a database in a broader way.

	 5.	 -- Create Students table 
		  CREATE TABLE Students ( 
		  StudentID INT AUTO_INCREMENT PRIMARY KEY, 
		  FirstName VARCHAR(255), 
		  LastName VARCHAR(255), 
		  Email VARCHAR(255) UNIQUE, -- Candidate Key 
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		  StudentCode VARCHAR(255) UNIQUE, -- Alternate Key 
		  Birthdate DATE, 
		  Gender VARCHAR(10) 
		  ); 
		  -- Create Courses table 
		  CREATE TABLE Courses ( 
		  CourseID INT AUTO_INCREMENT PRIMARY KEY, 
		  CourseCode VARCHAR(10) UNIQUE, -- Candidate Key 
		  CourseName VARCHAR(255), -- Alternate Key 
		  InstructorID INT, 
		  StartDate DATE, 
		  EndDate DATE, 
		  FOREIGN KEY (InstructorID) REFERENCES Instructors(InstructorID) 
		  );
	 6.	 SQL constraints are used to define rules for table data. These rules control the data that can 

be stored in a column. Constraints are used to restrict the types of data that can be entered 
into a table.

		  To remove a primary key constraint from a column (e.g., Acc_No) in a table (e.g., Bank), you 
can use the ALTER TABLE statement.

		  ALTER TABLE Bank
		  DROP PRIMARY KEY;
		  This query will remove the primary key constraint from the Acc_No field in the Bank table. 

After executing this query, the Acc_No column will no longer be the primary key, and it may 
contain duplicate or NULL values, depending on whether a unique constraint or NOT NULL 
constraint was previously applied to it.

	 7.	 Scalable: It refers to the ability of systems to work easily with small amounts of data, large 
amounts of data, clusters of machines, and so on. The MySQL server was developed to work 
with large databases. 

		  Secure: It provides a secure interface since it has a flexible password system and ensures that 
it is verified based on the host before accessing the database. The password is encrypted 
while connecting to the server.

	 8.	 Data Definition Language (DDL): A Data Definition Language or Data Description Language 
(DDL) is a standard for commands that define the different structures in a database. DDL 
statements create, modify and remove database objects such as tables, indexes and users. 

		  Common DDL commands in SQL are: 
	 	 •	 CREATE DATABASE – Creates a new database 



29Touchpad Information Technology-XI (Answer Key)

	 	 •	 CREATE TABLE – Creates a new table 
	 	 •	 ALTER TABLE – Modifies a table 
	 	 •	 DROP TABLE – Deletes a table 
	 	 •	 TRUNCATE TABLE – Deletes all data of the table (removes all records from the table) 
		  Data Manipulation Language (DML): A Data Manipulation Language (DML) is a language 

that enables users to retrieve, update, insert and delete data in a database. 
		  Common DML commands in SQL are: 
		  It contains commands like SELECT, INSERT, UPDATE and DELETE. 
		  Examples of DML commands are: 
	 	 •	 SELECT – Extracts data from a table 
	 	 •	 UPDATE – Updates data in a table 
	 	 •	 DELETE – Deletes data from a table 
	 	 •	 INSERT INTO – Inserts new data into a table
C.	 1.	 SELECT * FROM STUDENT WHERE NAME = NULL; 
		  Error: Comparing with NULL should use IS NULL instead of = NULL.
		  Corrected Query: SELECT * FROM STUDENT WHERE NAME IS NULL; 
	 2.	 SELECT MAX(SALARY) FROM EMPLOYEE GROUP BY DESIGNATION WHERe DOJ> “2020.02.02”; 
		  Error: The keyword WHERe is not correctly capitalized. It should be WHERE. Also, the date 

format should be in single quotes: DOJ > ‘2020-02-02’; 
		  Corrected Query: SELECT MAX(SALARY) FROM GROUP BY DESIGNATION EMPLOYEE WHERE 

DOJ > ‘2020-02-02’;
	 3.	 SELECT * FROM STUDENT WHERE NAME = “Rakhi”; 
		  Error: Double quotes should be replaced with single quotes.
		  Corrected Query: SELECT * FROM STUDENT WHERE NAME = ‘Rakhi’; 
	 4.	 SELECT * FROM EMPLOYEE WHERE SALARY BETWEEN 2000,5000; 
		  Error: The values in the BETWEEN clause should be separated by AND, not a comma.
		  Corrected Query: SELECT * FROM EMPLOYEE WHERE SALARY BETWEEN 2000 AND 5000; 
	 5.	 SELECT * FROM EMPLOYEE WHERE NAME = “A%”; 
		  Error: The % wildcard character should be used with the LIKE operator for pattern matching.
		  Corrected Query: SELECT * FROM EMPLOYEE WHERE NAME LIKE ‘A%’; 
	 6.	 SELECT ALL FROM STUDENTS; 
		  Error: “ALL” is not used in SELECT queries. The correct keyword for retrieving all columns is 

*.
		  Corrected Query: SELECT * FROM STUDENTS; 
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	 7.	 SELECT NAME, SUBJECT FROM STUDENT WHERE AVERAGE >20 and <30; 
		  Error: The AND operator requires separate comparison expressions for each condition.
		  Corrected Query: SELECT NAME, SUBJECT FROM STUDENT WHERE AVERAGE > 20 AND 

AVERAGE < 30;
D.    Competency-based/Application-based questions:	
	 1.	 The command to create table is:
		  CREATE TABLE Student ( 
		  Rollno INT(5), 
		  Sname VARCHAR(200), 
		  Class INT(5), 
		  Contactno CHAR(10) NOT NULL, 
		  AdmNo VARCHAR PRIMARY KEY 
		  );  
	 	 i.	 INSERT INTO Student Values(1, ‘Neelam’, 11, ‘1234567890’, ‘235’);
	 	 ii.	 INSERT INTO Student (Rollno, Contactno, AdmNo) VALUES (2, ‘1111122222’, ‘1250’);
	 	 iii.	 UPDATE Student SET Contactno = ‘1002000109’ WHERE AdmNo = ‘235’;
		  iv.	 ALTER TABLE Student ADD DOB DATE;
		  v.	 Select * from Student;
		  vi.	 DROP TABLE Student;
	 2.	 i.	 SELECT * FROM Student; 
		  ii.	 SELECT Rollno, Name, Class FROM Student; 
	 	 iii.	 SELECT * FROM Student WHERE Name = ‘Kanchan’; 
	 	 iv.	 SELECT * FROM Student WHERE Class = ‘X’; 
		  v.	 SELECT * FROM Student WHERE Fee > 3500; 
	 	 vi.	 SELECT Fee FROM Student WHERE Name = ‘Raj Kumar’;
	 	 vi.	 SELECT * FROM Student WHERE Name = ‘Poonam’;
	 3.	 i.	 Number of attributes: 5 
		  ii.	 Number of tuples: 3 
		  iii.	 Cardinality: 3

	Fundamentals of Java

Unsolved Exercise

Section A  
(Objective Type Questions)

A.	 1.	 iv 	 2.	 i 	 3.	 i 	 4.	 i 	 5.	 ii 	 6.	 ii 	
	 7.	 iv	 8.	 iii 	 9.	 iv 	 10.	 ii
B.	 1.	 Label 
	 2.	 The question is printed incorrect in the book. Please correct it in your textbook.)
		  Question: The ................................ property sets the vertical alignment of the label’s content 

along the Y-axis.
	 Ans.	 verticalAlignment 
	 3.	 void setIcon 		 4.	 actionPerformed( ) 	 5.	 void append() 
	 6.	 Classes 			   7.	 encapsulation 			   8.	 Floating-point
	 9.	 Relational 			   10.	 Ctrl+S
C.	 1.	 True	 2.	 True	 3.	 True	 4.	 True	 5.	 True

Section B 
(Subjective Type Questions)

A.	 1.	 Frame and Panel are containers components in NetBeans.
	 2.	 The design area, also known as the GUI builder, is the main window where you can create 

and edit Java GUI forms. It has two toggle buttons named “Design” and “Source”, which are 
used to switch between the Design view and the Source view of the form.

	 3.	 A variable is a storage location on the computer’s memory where a particular type of value 
can be stored. In Java, each variable has a type that governs the memory size and layout, 
the range of values that may be stored within that memory, and the set of operations that 
can be applied to the variable.

		  Identifiers are the fundamental building blocks or units of a program that are used for naming 
classes, methods, variables, objects, etc. in a program.

	 4.	 Relational operators are used to compare two values or operands. They return either True 
or False. True or False are also referred to as 1 or 0 respectively. These operators need two 
operands to work. So, they are also known as binary operators. 

5.
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	 	 The following table shows the relational operators provided by Java:

Operator Name Description 

== Equal It checks if the values of two operands are equal 
or not. If yes, then the condition becomes true. 

!= Not equal 
It checks if the values of two operands are equal 
or not. If the values are not equal, then the 
condition becomes true. 

> Greater than 
It checks if the value of the left operand is greater 
than the value of the right operand. If yes, then 
the condition becomes true. 

< Less than 
It checks if the value of the left operand is less 
than the value of the right operand. If yes, then 
the condition becomes true. 

>= Greater than or 
equal to 

It checks if the value of the left operand is greater 
than or equal to the value of the right operand. If 
yes, then the condition becomes true. 

<= Less than or 
equal to 

It checks if the value of the left operand is less 
than or equal to the value of the right operand. 
If yes, then the condition becomes true. 

	 5.	 The ButtonGroup manages the selected/unselected states of a group of buttons. One button 
can only be selected for the group at a time thanks to the ButtonGroup instance. Usually, a 
button group is used with check box and a radio button control.

B.	 1.	 A variable is a storage location on the computer’s memory where a particular type of value 
can be stored. In Java, each variable has a type that governs the memory size and layout, 
the range of values that may be stored within that memory, and the set of operations that 
can be applied to the variable. 

		  Static Variables 
		  A variable that is declared inside a class using the static keyword is known as a static variable. 

A single copy of a static variable can be used among all the instances of the class. Memory 
allocation for static variables happens only once when the class is loaded in the memory. 

		  The static variables are used when the value of a variable is independent of the objects (not 
unique for each object). For example, number of students.

	 2.	 Some properties of the Password component: 
	 	 •	 �Background: It specifies the font of the text to be displayed in the Password Field 

component. 
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	 	 •	 �echoChar: It specifies the character that will be displayed instead of text in the Password 
Field component.

	 3.	 Sometimes, we have several options to display on the form, but we do not have enough 
space to show them. In such a situation, the Radio Button and Check Box components will 
not fulfil the requirement. Thus, in the case of too many options, we can use the Combo 
Box component as it helps save space and is less cumbersome to design than the Radio 
Button and Check Box components. The Combo Box component shows one option at a 
time. Similar to the Combo Box component, Java provides another component named List to 
show multiple options. However, a List component is a preferred option in situations where 
multiple options are required to be selected from a large number of known sets of options.

		  The selectedIndex property specifies the index number of the element which should be 
selected by default.

	 4.	 Arithmetic operators are used to perform mathematical operations like addition, subtraction, 
multiplication, division, modulus, etc. These operators work with two operands. So, they are 
called binary operators. Java provides the following arithmetic operators: 

Operator Name Description 

+ Addition It adds values on either side of the operator. 

– Subtraction 
It subtracts the right-hand operand from the  
left-hand operand. 

* Multiplication It multiplies values on either side of the operator. 

/ Division It divides the left-hand operand by the right-hand 
operand. 

% Modulus It divides the left-hand operand by the right-hand 
operand and returns remainder. 

	 5.	 if statement
	 	 ‘if’ statement is a decision-making statement. It is applied in a situation when the output of 

expression is True (i.e., Yes), then a course of action or the statement is executed, otherwise, 
the course of action or the statement is ignored.

		  Syntax: 
			   if(test expression)

				  Statement;

		  if-else statement
	 	 ‘If ……. else’ statement is a decision-making statement. It is applied in a situation when the 

output of an expression is True (i.e., Yes), then it follows one direction of execution/statement 
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otherwise if it is False (i.e., No), then it follows the other direction of execution.
		  Syntax: if (test expression)
			  True-block statements(s);

		 else

			  False-block statement(s);

		  If the test-expression is true, then the true block statement(s), is immediately executed 
otherwise the false block statement(s) is executed. In either case, only one case statement 
is executed at a time either True-block or False-block.

	 6.	 Switch is a keyword. It is a built-in multiple decision-making statement. The switch statement 
tries to match the value of a given variable (or expression) with a list of values which are 
attached to the case statement and when a match is found, the block of statement(s) 
associated with that case is executed (case is a keyword).

		  If the value of the expression do not match with any of the case values, then the default 
statement will be executed (default is also a keyword). The default statement in switch is 
optional.

	 7.	 i.	� The Text Field is a lightweight component. It is an input area where the user can type 
small amounts of text. Whereas, the Text Area component allows us to accept multiple 
lines of input from the user or display multiple lines of text. It automatically adds vertical 
or horizontal scroll bars as and when required during runtime.

		  ii.	� A ComboBox is a combination of a text field and a drop-down list whereas, a ListBox is 
a list of items from which the user can select one or multiple items.

	 8.	 A List component in Java is a preferred option in situations where multiple options are required 
to be selected from a large number of known sets of options. The different selection modes 
of a list are as follows:

	 	 •	 �SINGLE_SELECTION: This mode allows only one item to be selected at a time. Clicking 
on a new item deselects the previously selected item.

	 	 •	 �SINGLE_INTERVAL_SELECTION: Similar to SINGLE_SELECTION, but also allows for 
selecting a contiguous range of items. Clicking on a new item while holding down the 
Shift key selects the range from the previously selected item to the currently clicked item.

	 	 •	 �MULTIPLE_INTERVAL_SELECTION: This mode allows for the selection of multiple 
items, whether contiguous or non-contiguous. Clicking on an item selects or deselects 
it without affecting the selection state of other items. Holding down the Ctrl key while 
clicking allows for selecting multiple non-contiguous items.

C.    Competency-based/Application-based questions:	
	 1.	 Aadarshmita can use the TextArea component to accept multiple lines of text from the user.
	 2.	 Priyanshi can use the Label component to display non-editable text on the form. 
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	 3.	 The question is printed incorrect in the book. Please correct it in your textbook.)
	 	 Viraj has written the following code in Java. 
		  String dayName;
		          switch (dayOfWeek) {
		              case 1:
		                  dayName = “Monday”;
		                  break;
		              case 2:
		                  dayName = “Tuesday”;
		                  break;
		              case 3:
		                  dayName = “Wednesday”;
		                  break;
		              case 4:
		                  dayName = “Thursday”;
		                  break;
		              case 5:
	 	                 dayName = ‘Friday’;
		                  break;
		              case 6:
		                  dayName = “Saturday”;
		                  break;
		              case 7:
		                  dayName = “Sunday”;
		                  break;
		              default
		                  dayName = “Invalid day”;
		          }
		  When he runs the code to see the output, the computer shows some errors. Rectify the 

errors and help him to get the correct output. 
	 Ans.	 There are a couple of errors in the provided code:
	 	 •	 In the case for Friday, you’re using single quotes instead of double quotes for the string 

value “Friday”.
	 	 •	 There’s a syntax error in the default case. You need a colon (:) after default to indicate 
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the start of the block of code for the default case.
		  Corrected Code:
		  String dayName;
		          switch (dayOfWeek) {
		              case 1:
		                  dayName = “Monday”;
		                  break;
		              case 2:
		                  dayName = “Tuesday”;
		                  break;
		              case 3:
		                  dayName = “Wednesday”;
		                  break;
		              case 4:
		                  dayName = “Thursday”;
		                  break;
		              case 5:
		                  dayName = “Friday”;
		                  break;
		              case 6:
		                  dayName = “Saturday”;
		                  break;
		              case 7:
		                  dayName = “Sunday”;
		                  break;
		              default:
		                  dayName = “Invalid day”;
		          }


